
1

.

.Operating Instructions

.for VPT Experiments

.at UVa’s HEP Laboratory

.Written by

.John Christopher Jones

.Summer 2010

.[DRAFT]



Contents 1

Contents i 2

List of Figures ii 3

List of Tables ii 4

1 Preamble 1 5

1.1 How This Document Was Written . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1 6

1.2 Conventions Used in This Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1 7

1.3 Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2 8

2 Overview 3 9

2.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 10

2.2 Experimental Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 11

I Equipment 6 12

3 Superconducting Solenoidal Magnet 7 13

3.1 Cryogen System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7 14

3.2 Warnings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8 15

4 The Rig 9 16

4.1 Amplifier Board [fixme]� . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9 17

4.2 LED Pulser Boards [fixme]� . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9 18

4.3 Vacuum Photo-triodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10 19

5 High Voltage Supply 14 20

6 Low Voltage Supply 16 21

7 National Instruments 18 22

7.1 PXI Crate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18 23

7.2 LabVIEW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20 24

7.3 ReadyNAS (RNAS) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22 25

II Operations Manual 23 26

8 Getting Started 24 27

8.1 Installing LabVIEW 2009 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24 28

8.2 Installing the VPT VIs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24 29

8.3 Getting the Latest Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25 30

9 PXI Crate 27 31

9.1 Logging into the PXI Crate (RDP) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27 32

9.2 Launching LabVIEW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27 33

9.3 Opening Project VPT Stability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27 34

9.4 Starting Data Acquisition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27 35

9.5 Stopping Data Acquisition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27 36

9.6 Restarting Data Acquisition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27 37

9.7 Resuming Data Acquisition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28 38

9.8 Shutting Down The Crate (software) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28 39

9.9 Powering On Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28 40

9.10 Powering Down Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28 41

i



10 Low Voltage Supply 29 42

10.1 Panel Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29 43

10.2 Setting Voltage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29 44

10.3 Setting Current . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29 45

10.4 System Set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29 46

11 High Voltage Supply 30 47

11.1 Verifying Cable Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30 48

11.2 Verifying the Voltage Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30 49

11.3 Killing the High Voltage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30 50

11.4 Ramping Down the High Voltage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30 51

11.5 Ramping Up the High Voltage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31 52

11.6 Turning Off the High Voltage System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31 53

11.7 Turning On the High Voltage System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31 54

12 Vaccum Photo-triodes (VPTs) 32 55

12.1 Cleaning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32 56

12.2 Mounting VPTs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32 57

13 Maintainence 33 58

13.1 Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33 59

13.2 Measuring Cryogen Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33 60

13.3 Filling LN2 Cryogen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 61

13.4 Ordering LN2 Cryogen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 62

13.5 Filling LHe Cryogen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 63

13.6 Ordering LHe Cryogen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 64

List of Figures 65

1 Schematic View of CMS Electromagnetic Calorimeter . . . . . . . . . . . . . . . . . . . . . . . . 3 66

2 Rig Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4 67

3 Signal Path in Teststand . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5 68

4 Distribution Box for Cathode Signal to Terminal Block . . . . . . . . . . . . . . . . . . . . . . . 5 69

5 Top-down external view of Superconducting Solenoidal Magnet . . . . . . . . . . . . . . . . . . . 7 70

6 VPT Angle Adjustment Lever . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9 71

7 Photograph of Vacuum Photo-Triode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10 72

8 VPT Electron Action . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10 73

9 VPT Electron Potential Well (qualitative) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11 74

10 VPT Pulse Shape . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11 75

11 VPT Angle Repsponse Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12 76

12 VPT Long Term Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12 77

13 Front Panel of the SY1527LC System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14 78

14 BK Precision 9130 Front View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16 79

15 Front View of the PXI-1042 Chasis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18 80

16 PXI Local Bus and Star Trigger Routing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19 81

17 LabVIEW Block Diagram of Host - Main.vi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20 82

18 LabVIEW (default) Icon and Connection Panels . . . . . . . . . . . . . . . . . . . . . . . . . . . 21 83

19 LabVIEW Arrangement Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21 84

20 Kimtech Science Kimwipes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32 85

List of Tables 86

1 Keyboard Symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2 87

2 CAEN Nuclear Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15 88

3 DC Power Supply Channel Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16 89

ii



List of Tables iii

4 DC Voltage Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17 90

5 High Voltage Group 01 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30 91



1. PREAMBLE 1

1 Preamble 92

1.1 How This Document Was Written 93

This document was written in LATEX, and was compiled with XƎTEX 0.94 from MacTEX 2009 for Unicode 94

support. The Lucida Grande font is used for sans-serif typefaces, available on Mac OS X. Anonymous Pro 95

is used for the monospaced font, also available on Mac OS X. 96

A number of LATEX packages were used. The document was typeset with the Memoir class. Graphics 97

are provided with the TikZ package. The glossary was constructed with the glossaries package. Tables 98

make use of the booktabs and multirow packages. Links are provided by the hyperref package. Several other 99

packages are loaded for symbol support: amsmath, textcomp, ucs, xunicode, xltxtra. 100

1.2 Conventions Used in This Text 101

1.2.1 Font Conventions 102

The following conventions are used in this text: 103

Example Description
File → Open For menu items, a sans-serif font is used with → between the menu

items.
keys For short key sequences that sould be pressed, a sans-serif font is used.

/foo/bar For directories, filenames, and paths, a mono-spaced font is used.
command -o file.ext For commands that should be entered literally into a terminal, a bold

mono-spaced font is used.
--file 〈named field〉 For options the user should supply, a brief description of the option is

surrounded in angle brackets.
LabVIEW For software, application names, and operating systems, a sans-serif

font is used.
CAEN The maker of a component is typeset this way.

CAEN SY1527LC The make (manufacturer) and model number of a component are type-
set this way.

SY1527 The model number of a component is typeset this way.

1.2.2 Advisories 104

⚠ AVOID hazards pointed out by the warning signs. 105

✓ DO read positive recommendations in boxes like this. 106

✗ DO NOT ignore negative recommendations without consulting with the experiment maintainer. 107
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1.2.3 Symbols Used 108

For brevity and consistency, a number of standard symbols are used to represent keyboard keys. These 109

conventions were largely adopted from Mac OS X. 110

Table 1: Keyboard Symbols
Symbol Name Also Known As

⇧ Shift —
⌃ Control —
⌥ Option Alt
⌘ Command Windows Key
⌦ Delete Right —
⌫ Delete Left —
⎋ Escape —
↩ Return Enter
← Left —
↑ Up —
→ Right —
↓ Down —
⇥ Tab —

Four of these keys are modifiers: ⌘, ⇧, ⌃, ⌥. These keys do nothing on their own (except for ⌘, which 111

toggles the Start Menu in Windows), and have to be combined with another character. This is denoted by 112

joining two keys, such as ⌘C (Copy, OS X) or ⌃C (Copy, Windows). 113

1.3 Links 114

If this document is viewed as a PDF, you’ll be able to follow hyperlinks throughout the document. These 115

links have different styles depending on their destination: 116

Example Description
Google External link to URI (hyperlink)

Manual.pdf External link to local companion files
§1.3 Links Internal link within the same document
LabVIEW Internal link to glossary definition

http://wwww.google.com
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2 Overview 117

2.1 Introduction 118

The University of Virginia is part of the CMS experiment at CERN. The CMS detector is a multistage 119

general purpose detector. The first inner stage of the detector is the electromagnetic calorimeter (Ecal). 120

The central cavity of CMS is cylindrical, with the beam coming in along its axis. The walls of the cylinder 121

are formed by the Ecal detectors. The rounded walls are the barrel, and at either end are the endcaps. 122

The detectors are made of two main components. The masses that react with the beam products are dense 123

inorganic PbWO4 (“lead-tungstate”) scintillator crystals. Behind those scintillators are the scintillation 124

detectors. In the barrel, these detectors are avalanche photodiodes (APDs). In the endcap, these detectors 125

are Vacuum Photo-Triodes (VPTs.) 126

Some of the main objectives of the CMS detector, such as the discovery of the Higgs boson, will be seen 127

primarily in the Ecal. If a light (<140GeV) Higgs boson is discovered, it will be from a H0 → 2γ decay. 128

Above 140GeV and through 600GeV the Higgs boson is predicted to decay into two Z bosons, which further 129

decay into four leptops, such as electrons and muons. Electrons and photons will be detected by the Ecal. 130

Taken from K.W. Bell et al., “Vacuum Phototriodes for the CMS Electromagnetic Calorimeter Endcap,” IEEE
Transactions on Nuclear Science, vol. 51, no. 5, pp. 2284-2287, 2004.

2284 IEEE TRANSACTIONS ON NUCLEAR SCIENCE, VOL. 51, NO. 5, OCTOBER 2004

Vacuum Phototriodes for the CMS Electromagnetic
Calorimeter Endcap

K. W. Bell, R. M. Brown, D. J. A. Cockerill, P. S. Flower, P. R. Hobson, B. W. Kennedy, A. L. Lintern, C. S. Selby,
O. Sharif, M. Sproston, and J. H. Williams

Abstract—The measurement of scintillation light from the lead
tungstate crystals of the Compact Muon Solenoid (CMS) electro-
magnetic calorimeter (ECAL) poses a substantial technical chal-
lenge, particularly in the endcap regions, where the radiation levels
are highest. The photodetectors must be fast, sensitive, radiation-
hard, and operate with significant internal gain in a magnetic field
of 4 Tesla. The measured performance characteristics of the first
batches of series production vacuum phototriodes (VPT), devel-
oped to satisfy the needs of CMS, will be described.

Index Terms—Calorimetry, photodetectors, photomultipliers.

I. INTRODUCTION

THE Compact Muon Solenoid (CMS) experiment [1] is
one of two general-purpose detectors currently being

constructed for operation at the LHC proton-proton collider at
CERN. The CMS electromagnetic calorimeter (ECAL) detector
[2] comprises an array of scintillating lead tungstate crystals;
the crystals are slightly tapered to generate a quasipointing ge-
ometry, as shown in Fig. 1. The barrel, of length 6 m and radius
1.75 m, contains approximately 61 000 crystals, while the end-
caps contain approximately 15 000 crystals, each crystal being
equipped with a photodetector. The endcap crystals are 30 30
mm in cross section and 220 mm long, corresponding to a
depth of approximately 25 radiation lengths. The calorimeter
lies inside the 4-T solenoidal magnetic field of CMS. The
benchmark physics channel which drives the ECAL design is
the decay of the Higgs boson to two photons; this will be the
most significant discovery channel for the Higgs if its mass
is less than 130 GeV/c . The detection of this decay process
above background requires that the energy resolution of the
ECAL must be less than 1% for photons of 100 GeV energy.

The experimental conditions expected at the LHC impose
stringent demands on the detector technology. The radiation
environment during collider operation will be very harsh. The
ECAL barrel will receive an integrated gamma dose of up to
4 kGy during 10 years of operation. The dose rate is a strongly
increasing function of rapidity, with an expected integrated dose
of several tens of kGy in the central region of the endcap, while
the dose at the inner edge of the endcap could be as high as

Manuscript received November 14, 2003; revised March 23, 2004. This work
was supported by PPARC.

K. W. Bell, R. M. Brown, D. J. A. Cockerill, P. S. Flower, B. W. Kennedy,
A. L. Lintern, M. Sproston, and J. H. Williams are with the CCLRC Rutherford
Appleton Laboratory, Chilton, Didcot, Oxfordshire OX11 0QX, U.K.

P. R. Hobson, C. S. Selby, and O. Sharif are with Brunel University, Depart-
ment of Electronic and Computer Engineering, Uxbridge, Middlesex UB8 3PH,
U.K.

Digital Object Identifier 10.1109/TNS.2004.836053

Fig. 1. Schematic view of CMS electromagnetic calorimeter. The vacuum
phototriodes will be mounted at the rear of the endcap crystals, seen in the
cutaway endcap on the left of the figure.

200 kGy [3]. The neutron fluence will also be intense, ranging
from cm in the ECAL barrel to cm at the inner
edge of the endcap. Radiation tolerance is therefore a vital con-
sideration in the detector design.

The LHC will operate at a frequency of 40 MHz, so that the
interval between beam crossings will be only 25 ns. The ECAL
must therefore be capable of responding on this timescale to
provide prompt information to the triggering system.

A further constraint on the ECAL photodetector arises from
the fact that the scintillation light output of lead tungstate is
rather weak; the Y/Nb-doped crystals used in CMS typically
yield 50 photons per MeV of energy deposited, requiring the
use of a photodetector with internal gain.

Finally, the photodetectors must function satisfactorily in the
4-T solenoidal magnetic field of CMS.

The photodetectors chosen for the ECAL barrel are avalanche
photodiodes (APDs) [4]. The neutron radiation flux in the end-
caps is too severe for these solid-state detectors, and Vacuum
Phototriodes (VPTs) will be used. The properties of these de-
vices will be described in the remainder of this paper.

II. DESCRIPTION OF THE CMS VACUUM PHOTOTRIODES

A vacuum phototriode (VPT) is a single-stage photomulti-
plier. A schematic diagram of a VPT is shown in Fig. 2. The
anode of the device takes the form of a 10- m pitch mesh of
approximately 50% transparency; electrons liberated from the
photocathode are able to pass through the holes in the mesh to
strike the dynode, generating secondary electrons which are col-
lected on the anode.

0018-9499/04$20.00 © 2004 IEEE
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Figure 1: Schematic View of CMS Electromagnetic Calorimeter

As the beam comes in on-axis, the majority of the beam products are produced just off-axis. This means 131

that the endcaps receive the highest radiation dosage, and the detectors need to be especially hardened 132

against neutron radiation. The PbWO4 crystals scintillate in the visible spectrum, near 420 nm. The 133

faceplates of the VPTs are made of a radiation-hard UV-transmitting borosilicate glass. Glass tends to 134

darken when exposed to neutron radiation. The glass used for the VPT faceplates is manufactured in small 135

batches and is proven to have less than 10% transmission loss after a dose of 20 kGy over a 48 hour period 136

using a 60Co source, prior to being accepted for use in VPT production. 137

The exact performance characteristics of VPTs under extended optical loads in strong magnetic fields are 138

still being studied. The University of Virginia has previously studied their performance under temperature 139

variation, and also under a non-axial magnetic field (§4.3.1 Further Reading.) We are currently (Summer 140

2010) studying their long term response behavior, which has been shown to decay over time. 141

2.2 Experimental Setup 142

The experimental setup at UVa has two main sections: The PXI Crate and the Rig. The PXI Crate sends 143

signals from its ..2 Field Programmable Gate Array (FPGA) module to the rig’s LED boards. The boards 144

send a photon pulse to VPTs housed inside a 3.8T magnetic field, and the VPT translates those photons 145

into a charge on its anode. The anode signal is amplified by a Stephenson amplifier, and that amplified 146

signal is sent back to the PXI Crate’s ..3 Switch. The PXI Crate then processes and records the signals. 147
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Conceptually part of the rig, a high voltage supply provides a +800V and +600V potential difference to 148

the VPT’s anode and dynode, respectively. A low voltage supply provides power to the LED pulser boards 149

and the Stephenson amplifier. 150

Figure 2 is a conceptual view of the conduits between the components of the rig. The “Amp” branch 151

is a simplification. Only the VPT anode connects to the amp, which then connects to the ..7 Switch. The 152

VPT cathode bypasses the amp and connects to the ..3 Switch. The PIN diode (§2.2.2 VPT Branch), part 153

of the VPT node here, also bypasses the Amp to connect to the ..7 Switch. 154

..VPT

.LED Pulser Board .Amp†
.High-Voltage

.Low-Voltage

.PXI Crate

...3 / ..7 Switch. ..2 FPGA

.BN
C

.optical .circ
uit

.BNC

.cat
5 .cat5

.SH
V

C

† Conceptual node; anode only

Figure 2: Rig Connections

2.2.1 LED Branch 155

The FPGA sends three TTL signals to a set of powered line driver chips (74LS241N and 74LS241PC), which 156

then drives the TTL signals over BNC cables to the powered LED board. Each TTL signal corresponds to 157

a single LED. (§4.2 LED Pulser Boards [fixme]�) 158

Load Signal is a simple simulated collider beam signal, intended to represent photon activity during beam 159

events. 160

Soak Signal is a faux load between beam events to maintain the VPT’s response curve. 161

Reference Signal is a measurement pulse inserted between the load and soak pulses to measure the VPT’s 162

response characteristics. 163

Each of the three optical signals that the LED board emits are multiplexed (muxed) into five different 164

optical fibers, and terminate in light-sealed boxes containing a VPT and a PIN diode. The PIN diode’s signal 165

can be used to make adjustments do to variations in LED light output on a pulse-by-pulse basis. The light 166

from each fiber is projected onto the entirety of the VPT’s photocathode. So, in total, each VPT receives 167

three fibers (one from each LED), and there are five PIN diodes (one for each VPT) acting as references for 168

LED light output. 169

2.2.2 VPT Branch 170

A VPT (§4.3 Vacuum Photo-triodes) is a single stage photomultiplier. The VPT’s photocathode, dynode, 171

and anode accumulate charge as light impacts the photocathode, with the most charge accumulating on the 172

anode. As photons strike the photocathode, electrons are liberated. A large potential of +600V is driven 173

from the photocathode to the dynode, The current from the VPT’s anode and cathode are ultimately routed 174
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... ..2 FPGA ..LED Board .
.VPT
.PIN..

..Amp

.. ..7 Switch

.. ..3 Switch

.. ..1 System Controller

.. ..6 Oscilloscope

.. ..5 DMM..Humiter

.load
.reference

.soak
.load

.reference

.soak

.PI
N

.anode

.an
od

e

.cathode

.

. .Single Cable

. .Multiple Cables

Figure 3: Signal Path in Teststand

to the PXI Crate’s switches, and then on to the crate’s DMM or oscilloscope. Before that, they go through 175

an amplification stage. 176

The VPT’s anode is connected directly to a Stephenson amplifier (§4.1 Amplifier Board [fixme]�), which 177

connects to the ..7 high-frequency switch. The PIN diode signal passes unmodified to that same ..7 high- 178

frequency switch. The cathode signal cables connect to a distribution box near the PXI Crate. The dis- 179

tribution box then routes their signals to the terminal block on the ..3 low-frequency switch. All of these 180

signals leave the rig over BNC cables before terminating at or adjacent to the PXI Crate. 181

Figure 4: Distribution Box for Cathode Signal to Terminal Block

A temperature and humidity monitor is mounted next to the rig, and a single cat5 cable carries power to 182

it and returns its readings to the ..3 low-frequency switch via the distribution box. It connects via MOLEX 183

connector next to the cathode signal BNC connectors. 184
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3 Superconducting Solenoidal Magnet 187

.

Figure 5: Top-down external view of Superconducting Solenoidal Magnet

The laboratory at HEP houses a Type-I superconducting solenoidal (“supersolenoid”) electromagnet 188

wired for persistent operation. Lacking the flux-resistive characteristics of Type-II superconductors, a Type- 189

I superconducting electromagnet is able to maintain a constant field over the course of years, rather than 190

the weeks to months of a higher temperature Type-II supersolenoid. However, like all known Type-I super- 191

conductors, its critical temperature lies just north of 4K, necessitating that it be cooled with liquid helium 192

(LHe). 193

Similar to other small LHe cryogen systems, the supersolenoid uses a three-chamber system. The outer 194

chamber is under partial vaccum to insulate the interior chambers from ambient temperature. The middle 195

chamber is filled with liquid nitrogen to cool the interior chambers to a maximum of 78K. The innermost 196

chamber, which houses the superconducting solenoid, is filled with liquid helium. Liquid helium comes into 197

direct contact with the supersolenoid. 198

Superconducting magnets have a number of significant advantages over ferromagnetic solenoids. Operat- 199

ing at high currents, they can be relatively compact compared with their ferromagnetic cousins. Of practical 200

benefit in the lab, their interior (where the field direction and magnitude is nearly uniform) can be empty 201

and externally accessible, as in our lab. Ferromagnetic solenoids must house a ferromagnetic yoke along 202

their axis to achieve the field strengths of supersolenoids. When wired in persistent mode, a supersolenoid 203

requires no additional electrical power and may remain at full strength while disconnected from a power 204

source indefinitely. While in persistent mode, a supersolenoid’s field is more stable than a ferromagnetic 205

solenoid, which is practically advantageous when measurements must be taken over extended periods. 206

3.1 Cryogen System 207

Maintenance of the superconductor’s cryogen system is detailed in §13 Maintainence. The cryogens boil off, 208

and need to be monitored regularly, as detailed in §13.2 Measuring Cryogen Levels. 209

3.1.1 Liquid Nitrogen 210

The liquid nitrogen boils off at a rate of 10% per day when it is nearly full. The rate increases somewhat as 211

the tank approaches empty. It’s generally good policy to keep the LN2 level as high as possible, filling on 212

Mondays and Fridays in case a fill must be missed for some reason. 213

The liquid nitrogen is usually delivered in 240L dewars, such as the Taylor-Wharton XL-65 dewar. For 214

filling instructions, see §13.3 Filling LN2 Cryogen. 215

3.1.2 Liquid Helium 216

The liquid helium boils off at a rate of 10% per week. One full 250 L liquid helium dewar will fill the 217

magnet’s tank from 20% to around 95%. For filling instructions, see §13.5 Filling LHe Cryogen. 218
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3.2 Warnings 219

⚠ AVOID proximity to the magnet if you carry medical equipment, including remote monitors and pace- 220

makers. 221

⚠ AVOID contact with the outer casing while the high voltage is active. The central cavity of the magnet 222

houses high voltage equipment. Although the outer casing of the magnet should not carry an electric 223

potential, improper grounding, wiring, or cable failure may occur. The high voltage to this equipment 224

should be powered down before touching the outer casing of the magnet or the rig. 225

⚠ AVOID bringing magnetic materials near the magnet. The strength of the magnetic field grows inversely 226

to the cube of distance—that is, much faster than intuition may suggest. Screwdrivers, metallic watches, 227

and even metal glasses have been known to be pulled off of individuals passing by the magnet. Remember 228

to remove your wallet before approaching the 10 000 gauss line near the magnet, because it will erase 229

your credit cards. 230
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4 The Rig 231

The rig is a mounting system attached to the superconducting magnet. It includes mounts for the VPTs 232

themselves, in addition to the LED pulser boards and the Stephenson amplifiers. 233

The current rig was assembled during the 2009–2010 school year by Michael Balazs, Brian Francis, and 234

Benjamin H. “BH” Kent (Associate Machine Shop Foreman). It features a number of improvements over 235

the previous rig: 236

It can accomodate up to five (5) VPTs at once, up from two. It also has a notched lever on the rear to 237

rotate the VPTs from −25◦ → +25◦, up from 0 → 23◦. 238

Figure 6: VPT Angle Adjustment Lever

The LED boards are now mounted inside the field near the VPTs, clearing a large amount of floorspace 239

that was used for an articulating arm that protruded out of the field and limited the angle of rotation 240

available for the VPTs. A new housing has been constructed for the LED boards, VPTs, and Stephenson 241

amplifiers. 242

4.1 Amplifier Board [fixme]� 243

The Vacuum Photo-Triodess (VPTs) are connected directly to a high-speed low-noise charge amplifier. At 244

the heart of the amplifier circuit is a National Semiconductor CLC428 (datasheet), which is the “Stephenson 245

pre-amp chip.” [fixme]� (Talk to Mike. Having trouble following paper trail.) 246

4.2 LED Pulser Boards [fixme]� 247

[fixme]� The LEDs in use are probably 5mm LED RL5-B5515. [David Phillips et al] 248

http://www.superbrightleds.com/cgi-bin/store/index.cgi?action=DispPage&Page2Disp=/specs/b2_specs.htm
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4.3 Vacuum Photo-triodes 249

The electromagic calorimeter (Ecal) is composed of scintillators and scintillator detectors. The scintilators 250

are transparent PbWO4 crystals. These crystals are relatively weak scintillators, producing only ˜50 photons 251

per MeV. [K.W. Bell, et al.] As such, to reach the energy resolutions needed by CMS the photodetectors 252

must have a built-in gain mechanism with low noise production. In the barrel of CMS, Avalance Photo- 253

Diodes (APDs) are used. However, in endcap, where radiation levels much higher, Vacuum Photo-Triodes 254

(VPTs) are used. 255

Figure 7: Photograph of Vacuum Photo-Triode

A Vacuum Photo-Triode (VPT) is a specific electronic light sensor with a built-in photo-electron multi- 256

plier effect. Like a photodiode, it exploits the photoelectric effect to liberate electrons with incoming photons. 257

As photons strike the photocathode, electrons are ejected. (The photocathode has effectively infinite current 258

to replenish its electrons.) In addition to the energy from the incident photon, the electrons are imparted 259

with an additional 1400 eV of potential energy from the high voltage applied to the anode and dynode. 260

.. .

.Cathode
.0V

.

.Anode
.+800V

.

.Dynode
.+600V

.γ .e−.e− .e−

.e−
.e−
.e−.

Figure 8: VPT Electron Action

The emitted photoelectron falls towards the anode and may miss the anode mesh and collide with 261

the dynode, causing secondary electron emissions which will fall back towards the anode. If the initial 262

photoelectron hits the anode mesh, it may also cause secondary emissions which will impact the dynode and 263

cause tertiary emissions to fall back to the dynode. The electrons continue falling up and down the potential 264

energy well causing secondary emissions until their kinetic energy at the anode is less than the work function, 265

and so get absorbed without secondary emissions. This results in a rapid rise in output (anode) current 266
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followed by a slower fall off. This process is extremely fast, returning to zero current from a pulse of 420 nm 267

light in around 200 ns. 268

The 200 ns response time of VPTs makes them acceptable for use in CMS, which operates at 40MHz 269

(T = 25 ns). The chance of beam products interacting with the same barrel crystal before complete recovery 270

is small, and the occasional overlapping event can be detected accounted for. 271

.
.U(x)

.x

.Cathode

.Anode

.Dynode

Figure 9: VPT Electron Potential Well (qualitative)

Taken from Christine Drown’s PHY 393 Spring 2008 Paper

Figure 10: VPT Pulse Shape

When we test a VPT at HEP, we send a pulse of light from a single source (an LED) down at least 272

two different fibers. One fiber illuminates the photocathode of the VPT, while the other illuminates a 273

standardized PIN diode. We use the PIN diode’s output as a reference for the light input to the VPT. We 274

can then calculate the gain, or the amount of charge amplification the VPT provides. 275

VPTs have a number of interesting characteristics that need to be studied. One of the reasons VPTs 276

were chosen is that they continue to function in strong non-axial magnetic fields, due to their single-stage 277

photomultiplier design. However, they still exhibit varibility in their response within non-axial magnetic 278

fields. The field in CMS is not entirely uniform between the beam axis and the outer edges of the endcap. 279

Therefore, the relative gain of each VPT is affected by the direction of the magnetic field, which varies 280

continuously depending on how far from the beam axis the VPT is placed. 281

VPTs also demonstrate a burn-in effect which can sometimes be quite pronounced. The amplification 282

VPTs produce degrades over time, so that the same pulsed photocurrent will result in less output days later. 283

The effect is not permanent, however. The self-correcting behavior of VPTs was being studied at UVA 284

in 2009 when an electrical failure of the old NIM crate damaged several instruments and interrupted the 285

experiment. 286

4.3.1 Further Reading 287

• D.C. Imrie. Long-Term Behaviour Of Three Prototype Vacuum Phototriodes Operated With High 288

Photocurrents. January 2000. 289
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• M.N. Achasov, et al. Compact Vacuum Phototriodes for operation in strong magnetic field. 26 290
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• K.W. Bell, et al. Vacuum Phototriodes for the CMS Electromagnetic Calorimeter Endcap. October 292

2004. 293
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CMS ECAL. 299

• J.C. Jones. Long Term VPT Response of Vacuum Photo-Triodes. Fall 2008. 300
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5 High Voltage Supply 301

Our high voltage supply is made by CAEN. CAEN is one of the main companies responsible for the design 302

and manufacturing of components in ATLAS, CMS, ALICE, and LHCb. To date, CAEN has supplied the 303

LHC with 6138 units. The modular CAEN high voltage supply replaced an aging power supply in 2009. 304

Our high voltage modules are housed in an 8U-high 19 inch-wide CAEN SY1527LC Universal Multichannel 305

Power Supply System, which acts as a chasis and system controller for the various installed modules. The 306

SY1527 system has four main sections: On the front are the CPU and Front Panel section, and the Power 307

Supply section. On the rear are the Board Section and the Fan Unit. The LC designation means “low 308

cost,” and refers to lack of a built-in LCD screen, compact switch, alphanumeric keyboard, and I/O Control 309

section. 310

Taken from CAEN SY1527 User Manual, Figure 2.3

 
Document type: Title: Revision date: Revision: 
User's Manual (MUT) Mod. SY1527, universal multichannel power supply system 20/03/2008 15 

 
 

NPO: Filename: Number of pages: Page: 
00103/97:1527y.MUTx/15 SY1527USERMANUAL_REV15.DOC 87 20 

 

n CAEN
Nuclear

Interface Bus Reset
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Fig. 2.3 – Front panel of the SY1527LC system 

Table 2.4 – Technical specifications of the SY1527LC 

Displays 

 RESET, red/orange LED, lights up as a RESET occurs: it is initially red and then 
becomes orange, depending on the duration of the RESET signal; 

 OK, yellow LED, lights up as the system is turned on. 
 +5, +12, -12, +48, green LEDs, light up as the relevant power supply is present 

Switches 
 MAIN switch (rear panel) to power the Power Supply Section; 
 POWER ON key (front panel, primary power supply) to power on the system 

locally or to enable its remote power on. 

Buttons 
RESET push button: if TRESET > TRCPU = 100÷200 ms  CPU is reset; if TRESET
> TRCH = TRCPU+900 ms  CPU, boards are reset and the channels are turned 
off. Reset must be enabled via software (RESET FLAG window, see § 7.1.22). 

Remote 
Control 
Interfaces 

 H.S. CAENET; 
 LOCAL NET (ONLY for connection to a SY3527; see § 7.1.26); 
 One PS/2 connector for external PC keyboard; 
 VGA-standard connector for external VGA monitor; 
 ETHERNET (TCP/IP); 
 RS232 interface for external VT100 or PC. 

 

Figure 13: Front Panel of the SY1527LC System

The Power Supply Section houses up to four power supply units, which provide power to the whole system. 311

We use one optional power supply in addition to the primary power supply. The Board Section houses up 312

to 16 Channel Boards. We use two standard HV boards, which distribute high voltage to the experimental 313

rig. However, the system is capable of housing other types of boards, including low voltage and generic I/O 314

boards. (We do not use CAEN LV boards; for our needs they are cost prohibitive.) 315

The system may be controlled either locally or remotely. A small 7.7 inch color LCD and a standard PS/2 316

keyboard are attached to the system for local control. The system can be remotely controlled over RS232 317

(serial) or ethernet. Over ethernet, the system can be logged into via telnet. CAEN has also developed a 318

C language library (CAEN HV Wrapper) for remotely monitoring and controlling system parameters over 319

TCP/IP. (Currently, remote control is not set up.) 320

A key on the primary power supply (front, bottom-right module) may be set to Off, Local, or Remote. 321

Off completely powers down the rig, and immediately kills any voltage supply channels without ramping 322

down the voltage. Local powers on the system and provides local control via the LCD and keyboard. Remote 323

sets the system to allow a remote power-on using NIM, RS232, or ethernet. 324

http://www.caen.it/
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Model Number Location Description
SY1527LC Chasis Modular power supply chasis
A1531 Front Primary chasis power supply
A1532 Front Auxillary chasis power supply
A1833D Rear Positive high voltage supply
A1833N Rear Negative high voltage supply

Table 2: CAEN Nuclear Components

✗ DO NOT power down the system by turning the key on the primary power supply without first initiating 325

a software-controlled ramp-down. 326

✓ DO power down the rig by first setting all of the channels to ramp down, and then turning off the system 327

with the key. 328

For detailed information on the SY1527 system see the CAEN SY1527 User Manual. 329

At present, only the positive HV channel board is used to supply +800V and +600V to the five VPT 330

anodes and dynodes, respectively. These ten cables run across the floor to the magnet and connect to the 331

rig. 332

For further operating instructions, see §11 High Voltage Supply. 333
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6 Low Voltage Supply 334

Most of the pieces of equipment in the rig have low voltage and current requirements. For our external 335

power supply, we use two BK Precision 9130 Triple Output Programmable DC Power Supplies. 336

Taken from BK Precision 9130 Manual.

 

 

 
 

 

 

Model 9130 
Triple Output Programmable DC Power Supply 

 
 

 
 

 
 
 

 
INSTRUCTION 

MANUAL 
 

 

MODEL 9130 

Figure 14: BK Precision 9130 Front View

The BK Precision 9130 Triple Output Programmable DC Power Supply has three independent outputs 337

providing 0–30V & 0–3A on two channels, and 0–5V & 0–3A on a third. It can be remotely controlled over 338

USB or RS232. It is also rack mountable, at 2U×½U. 339

Supply Channel Voltage Current Distributed to…
1 1 12.0 V 0.665 A LCD Monitor Power
1 2 12.0 V 0.082 A LED Pulser Board Power, Humiditer Power
1 3 5.0 V 0.045 A LED Pulser Board Voltage Bias, Trigger’s Pulse Gen-

erator Chip Power
2 1 10.0 V 0.421 A Supply 2 is wired in series to provide a ±5V supply

relative to the ground shared by the Stephenson
Amp and FPGA, rather than a floating ground.

2 2 0.0 V 〈OFF〉
2 3 Series CH1+3

Table 3: DC Power Supply Channel Configuration

For detailed information on the external power supplies, see the BK Precision 9130 Manual. 340

Table 3 lists the voltage each channel is set to, and what it is currently connected to. Table 4 lists the 341

cables which require low voltage supplies and where they’re currently connected. 342

The FPGA is capable of meeting the voltage and current requirements for the LED boards, and directly 343

connecting them would also allow the LED bias to be controlled directly by the FPGA. That would permit 344

us to control the photocurrent automatically. They were removed from the FPGA while tracking down a 345

source of signal noise, and may be safely re-attached to the FPGA at a later date. 346

The “Trigger Pulse Generator Chip” is a pair of a 74LS241N and 74LS241PC line drivers, chips designed 347

to be able to drive signals over BNC cables. The trigger signals run from the FPGA to the generator chips 348

and then on to the LED boards themselves. The FPGA isn’t capable of driving the BNC cables directly. 349
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Cable Name Cable Pair Voltage Supply

LED Voltage

blue LED Bias ±5V Supply 1, Ch 3
green LED Bias ±5V Supply 1, Ch 3

orange LED Bias ±5V Supply 1, Ch 3
brown LED Power ±12V Supply 1, Ch 2

Stephenson Amp ±5V to earth ground Supply 2

Local Power blue Trigger Pulse Gen ±5V Supply 1, Ch 3
brown Not used ±12V Supply 1, Ch 2

Humiditer green Power ±12V Supply 1, Ch 2
LCD Panel red & black Power ±12V Supply 1, Ch 1

Table 4: DC Voltage Requirements
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7 National Instruments 350

7.1 PXI Crate 351

The National Instruments PXI Crate is a programmable experimental test-stand capable of automating 352

many aspects of an experiment. It can be configured to control the experiment, perform advanced analog 353

and digital signalling and sampling, control power supplies, perform DAQ, process and export data, and 354

more. 355

7.1.1 NI PXI-1042 Chasis 356

What we refer to as the “PXI Crate” or just “the crate” is a National Instruments (NI) NI PXI-1042 series 357

chasis and the NI-designed modules it houses. The chasis itself is a Compact 3U rack-mountable chasis 358

that provides Universal AC, a power overload breaker, air temperature regulation, and a removable modular 359

power supply. In most cases, replacing a faulty component can take seconds. 360

Taken from National Instruments NI PXI-1042 Series User Manual and Specifications

Chapter 1 Getting Started

© National Instruments Corporation 1-3 NI PXI-1042 Series User Manual

• Front-panel LED that can indicate power supply failure

• Carrying handle for portability

• Tilt feet for bench-top applications

Chassis Description
Figures 1-1 and 1-2 show the key features of the PXI-1042 chassis 
front and back panels. Figure 1-1 shows the front view of the PXI-1042. 
Figure 1-2 shows the rear view of the PXI-1042. Figure 1-3 shows the 
rear view of the PXI-1042Q.

Figure 1-1.  Front View of the PXI-1042 Chassis

1 Backplane Connectors (Located in Slots 1–8)
2 On/Off (Standby) Power Switch
3 Removable Feet
4 Power LED
5 Controller Expansion Slots

6 System Controller Slot
7 Star Trigger Slot
8 Peripheral Slots
9 Filler Panel
10 Chassis Model

8

2

3

3

3

1

NI PXI-1042

76 954

10

Figure 15: Front View of the PXI-1042 Chasis

The chasis backplane supplies several busses to each slot. First, all modules share the 64-bit CompactPCI- 361

compatible PXI bus. Second, a Star Trigger Bus originates from Slot ..2 , and connects to the other six 362

peripheral slots. Third, a Local Bus connects all seven peripheral slots in a daisy chain; the left-local bus 363

signals on Slot ..2 are used for Star Trigger, and the right-local bus signals on Slot ..8 are not routed. The 364

Local Bus is 13-lines wide and can pass anything from high-speed TTL to analog signals up to 42V. Fourth, 365

the Trigger Bus provides eight shared trigger lines to all eight slots. Finally, the chasis supplies a 10 MHz 366

system reference clock signal (PXI_CLK10) independently to each peripheral slot. The clock signal is also 367

accessible externally via rear-mounted BNC connectors. 368
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Taken from National Instruments NI PXI-1042 Series User Manual and Specifications

Chapter 1 Getting Started

NI PXI-1042 Series User Manual 1-8 ni.com

Figure 1-4.  PXI Local Bus and Star Trigger Routing

Trigger Bus
All slots share eight trigger lines. You can use these trigger lines in a variety 
of ways. For example, you can use triggers to synchronize the operation of 
several different PXI peripheral modules. In other applications, one module 
can control carefully timed sequences of operations performed on other 
modules in the system. Modules can pass triggers to one another, allowing 
precisely timed responses to asynchronous external events the system is 
monitoring or controlling.

System Reference Clock
The PXI-1042 Series chassis supply the PXI 10 MHz system clock signal 
(PXI_CLK10) independently to each peripheral slot. An independent 
buffer (having a source impedance matched to the backplane and a skew of 
less than 250 ps between slots) drives the clock signal to each peripheral 
slot. You can use this common reference clock signal to synchronize 
multiple modules in a measurement or control system. You can drive 
PXI_CLK10 from an external source through the PXI_CLK10_IN pin 
on the P2 connector of the Star Trigger Slot. Refer to Table B-4, P2 (J2) 
Connector Pinout for the Star Trigger Slot. Sourcing an external clock on 
this pin automatically replaces the backplane’s 10 MHz source. You also 
can drive PXI_CLK10 from the 10 MHz REF IN connector on the rear of 
the chassis. Sourcing an external clock on this connector automatically 

Star Triggers
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Figure 16: PXI Local Bus and Star Trigger Routing

7.1.2 Modules 369

The chasis at HEP is configured with the following modules, described in the following sections: 370

..1 PXI-8104 Embedded Computer A full-featured embedded computer running Windows XP (down- 371

graded from Windows Vista Business by default by NI). This module ultimately controls all the other 372

components in the crate. It hosts an RDP server for remote login. The maximum amount of RAM has 373

been installed, 2 GiB, as two SO-DIMMs of PC2-5300 1 GiB, 128 MiB×64, CL 5, 1.18 inch max (NI 374

part number 779302-1024). It also features a Celeron M 440 (1.86 GHz single-core), a 60 GB SATA 375

hard drive, and gigabit ethernet. As it occupies the System Controller slot, it is generally referred to 376

as the system controller in NI literature. For detailed information see the PXI-8104 User Manual. The 377

internal hard drive is only used for system and experiment software. All experimental data is stored 378

on the ReadyNAS. 379

..2 PXI-7851R FPGA Essentially a reprogrammable integrated circuit, the FPGA controls all the real-time 380

trigger signals. The module itself has a break-out box connector, and the break-out box houses the 381

connections to devices which receive external trigger signals. (Namely, the LED pulser boards.) The 382

break-out box is an NI SCB-68. 383

..3 [fixme] 24-Channel two-wire Multiplexer Referred to as “the switch.” Featuring a single large 384

external port, the switch connects any of the 24 two-wire channels to the internal busses. The switching 385

mechanism is software controlled. An NI TB-2605 multiplexing terminal block is currently mounted 386

directly on it. This switch receives the cathode current and humiter signals and routes them to the 387

DMM. 388

[fixme]�This is either an PXI-2501 or PXI-2503 multiplexer. 389

..4 PXI-4110 DC Power Supply A software-controlled DC power supply, not currently in use. 390

..5 PXI-4071 PXI Digital Multimeter A software-controlled Digital Multimeter. 391

..6 PXI-5154 Digitizer/Oscilloscope A high frequency (2 GS/s) oscilloscope, optimized for automated 392

testing. 393

..7 PXI-2593 16-Channel Multiplexer A 16-channel high frequency switching multiplexer, able to handle 394

frequencies from DC to 500 MHz. This switch receives the anode and PIN diode signals and routes 395
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them to the oscilloscope. 396

[fixme]�All signals requiring measurement are routed from this multiplexer to either the DMM or the 397

Oscilloscope. 398

[fixme]�Wouldn’t it make more sense for this multiplexer to be adjacent to the 24-channel multiplexer 399

so that they could communicate directly over the local bus? 400

7.2 LabVIEW 401

Figure 17: LabVIEW Block Diagram of Host - Main.vi

LabVIEW is a graphical programming environment used for developing programs called virtual instru- 402

ments, or Virtual Instruments (VIs), which imitate physical instruments. LabVIEW uses a visual program- 403

ming language called “G” for building virtual instruments. “G” is a data-flow driven language, as opposed 404

to a procedural like C or functional language like LISP or Haskell. [fixme]�(rephrase) In LabVIEW program 405

execution is determined by the availability of data to the components inside a VI. As such, LabVIEW’s 406

programs are inherently parallel, meaning that different parts of the program can run simultaneously. 407

To get started with LabVIEW right away, read the manual Getting Started with LabVIEW. This manual 408

is also available from within the LabVIEW 2009 “Getting Started” dialog when the application is launched, 409

in the right-hand pane under “Help.” 410

For historical background on LabVIEW, see the Wikipedia entry. 411

The remainder of this section is a conceptual crash-course in LabVIEW. For hands-on practice, …[fixme]� 412

7.2.1 Block Diagram and Front Panel 413

A Virtual Instrument (VI) is a program in LabVIEW for which LabVIEW provides a visual programming 414

interface. Every VI has a front panel, which is a visual representation of its inputs and outputs, and a block 415

diagram, which is a functional diagram of how to process its inputs and to produce its outputs. The actual 416

programming of a VI takes place in the block diagram. However, you generally start creating the VI from 417

the front panel, much like how you generally start writing a function with its interface or signature. 418

A VI may be made of atomic logic units, like numbers, arithmetic, and control structures like loops and 419

conditional branches. It will contain any widgets you created on the front panel. It may also contain any 420

number of additional VIs. VIs referenced within another VI are called “sub-VIs,” for the sake of discussion, 421

but are otherwise the same as any other VI. 422

http://en.wikipedia.org/wiki/LabVIEW
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Figure 18: LabVIEW (default) Icon and Connection Panels

From the front panel, a small icon is visible in the upper right-hand corner of the window. This is how 423

the VI appears when placed in another VI. If you right-click this icon from the front panel (only) and select 424

“Show Connector” and then a component on the front panel, you’ll reveal connection pins that you can 425

assign to front panel components by clicking the pin and then a front panel component. If you use this VI as 426

a sub-VI, you’ll be able to fill in front panel inputs and read front panel outputs from another VI by using 427

the pin connections. 428

The block diagram will automatically be populated with the required components for the front panel and 429

the pin connections you’ve designated from the front panel. Connections between block diagram components 430

can be made by clicking on the small pin-out location you wish to start from and the small pin-in location 431

on the destination. A wire will be drawn from the source to the destination. The style (color, thickness, 432

pattern) will indicate its type. LabVIEW will only allow you to complete connections between compatible 433

types, but it will automatically insert conversion components for you, if possible. New components may be 434

dragged onto the block diagram from the “Controls” palette. 435

The exact behavior produced by a left-click varies with the click’s distance from an element. For instance, 436

clicking adjacent to a wire splices a branching connection into the wire, while clicking exactly on the wire 437

allows you to select the wire itself. The cursor will change to help you determine what will happen. 438

Figure 19: LabVIEW Arrangement Buttons

Because editing with the mouse can be a bit tedious, LabVIEW has a number of tools to automate a lot 439

of large-scale housekeeping on block diagrams. Under the Edit menu, you can automatically Remove Broken 440

Wires and Clean Up Diagram. In the toolbar of the block diagram, you’ll find menus to align, distribute, 441

group/layer, and clean up selected components. 442

7.2.2 Projects and VIs 443

A collection of LabVIEW files and [non-LabVIEW files] that you can use to create build speci- 444

fications and deploy or download files to targets. 445

—Definition of project from Getting Started with LabVIEW 446

A project in LabVIEW is a somewhat informal collection of files which can aggregate dependencies and 447

help build and deploy files to targets. A project is not even necessary for most tasks in LabVIEW and VIs 448

can be designed and run without creating a project. This is a little different from a lot of development suites, 449

which use projects to define the development environment. (VIs run in the proprietary LabVIEW runtime 450

environment, which handles things like execution, compilation, and dependency resolution.) 451

You need to use a project if you need to build and deploy a file to a target, such as an FPGA or some 452

other statically programmed instrument. Other than that, projects have little to do with the programming 453

and running of VIs. 454

7.2.3 Documentation 455

There are a number of useful sources of documentation for LabVIEW. 456

One of the most useful tools is the Context Help, found under Help → Show Context Help. This will 457

reveal a palette window that will give you information about whatever component you hover the mouse 458

over. For instance, when hovering over a wire it will tell you the data type the wire caries. If you hover over 459
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a component on the block diagram, it will tell you what that component does, what its connections are, and 460

which are optional. You can also get detailed help on anything you can get context help on by clicking the 461

question mark on the lower edge of the context help window. (Select the component to keep the context 462

help fixed on it.) 463

Usually the best way to find out how to do something new is to find an example. The example search 464

engine can be found in LabVIEW by navigating to Help → Find Examples…. One of the directories listed 465

under “Browse” tab is called “Fundamentals,” which will show you how to deal with the basics, such as basic 466

data types, control structures, and file I/O. Going through most of the examples in this directory will help 467

you become familiar with the visual vocabulary of LabVIEW. 468

The official National Instruments forums are also a useful source of information. 469

In addition, the UVa Site License includes a support contract. For help …[fixme]�. 470

7.3 ReadyNAS (RNAS) 471

The ReadyNAS (RNAS) is a ready-made NAS solution. NAS is an acronym for Network-Attached Storage, 472

a file-level (as opposed to block-level) remote storage system. The NetGEAR ReadyNAS NV+ acts as a 473

network filesystem for the PXI Crate in addition to the crate’s native filesystem on its local SATA hard 474

drive. The RNAS is backed up daily by Brian Wright. 475

Much of your interaction with the crate will happen indirectly, via the RNAS. You’ll usually want to 476

edit VIs locally and then upload them to the RNAS when its time to update the experiment’s software. VIs 477

are usually programmed to log their data to the RNAS, so you’ll retreive the latest data from the RNAS as 478

well. 479

The main exception to this is any VI which requires access to the crate’s peripheral hardware, such as 480

the FPGA, DMM, oscilloscope, or switches. These components need to be programmed and tested from 481

LabVIEW on the PXI Crate itself, as in §9.1 Logging into the PXI Crate (RDP). 482

The RNAS is configured for FTP access. For FTP directions, see §8.2 Installing the VPT VIs and 483

§8.3 Getting the Latest Data. 484

✗ DO NOT upload VIs without first making sure that LabVIEW on the crate has closed those VIs. 485

✗ DO NOT directly edit VIs or use viewing or processing VIs to view or edit data directly from the RNAS 486

if you have chosen to mount the remote filesystem. You may corrupt LabVIEW state (on the crate or 487

your own computer), or cause availability or timing errors in ongoing experiments. 488

✓ DO make a local copy of any VI or data you wish to use. You may safely copy data files while they are 489

being written to. 490

http://forums.ni.com/ni/
http://www.netgear.com/Products/Storage/ReadyNASNVPlus.aspx
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8 Getting Started 493

8.1 Installing LabVIEW 2009 494

You will need access to LabVIEW to start and stop experiments, to view data, and to export data. 495

As of Summer 2010, you’ll need LabVIEW 2009. The National Instruments site-licensed installation 496

discs are located in the HEP building in a small square black CD-sized zipper pouch with a blue spine. The 497

pouch’s spine is labeled National Instruments Academic Site License 2009: Software for Classrooms, Labs 498

& Research. 499

8.1.1 Mac 500

Locate the white DVD labeled “NI LabVIEW 2009.” This disc also bears the label “Third Quarter 2009” 501

on the left-hand side. Insert the disc and install the package titled LabVIEWPro2009.mpkg. You’re done. 502

8.2 Installing the VPT VIs 503

Copy the most recent VPT VIs from the ReadyNAS to a convenient location. Their remote location is: 504

ftp://hep-diskarray.physics.virginia.edu/teststand/VPT Stability Scanner/v3.0 - 5 VPTs 505

All data is stored on the ReadyNAS (see 7.3) and accessible via FTP. Open an FTP connection to 506

ftp://hep-diskarray.physics.virginia.edu/ 507

The “/teststand/” directory contains all of the data which is intended for use by the PXI Crate. To 508

install the latest version of the VPT Stability Scanner VIs, download the directory 509

/teststand/VPT Stability Scanner/v3.0 - 5 VPTs 510

If you’re unfamiliar with FTP, you may use any of the following methods: 511

8.2.1 Method 1: Using Finder 512

First, connect to the server. To do this for the first time: 513

1. Select Finder from the Dock. 514

2. Press ⌘K (or select Go → Connect to Server from the menubar) 515

3. Enter the server address as 516

ftp://teststand:labview@hep-diskarray.physics.virginia.edu 517

4. (optional) Click the “+” button to add it to your favorite servers. 518

5. Press the Connect button. 519

If you’ve added the server to your favorites and later “eject” the server, you can reconnect by the following 520

procedure: 521

1. Select Finder from the Dock. 522

2. Press ⌘K (or select Go → Connect to Server from the menubar) 523

3. Select ftp://teststand:labview@hep-diskarray.physics.virginia.edu from the favorites list. 524

4. Press the Connect button. 525
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Opening an FTP site in Finder works exactly like any regular folder in Finder. If you like, you can 526

switch the view to “Browser Mode” by hitting the clear oblong oval in the far upper right hand corner of 527

the window. 528

Navigate to teststand → VPT Stability Scanner and drag v3.0 - 5 VPTs to a convenient location. 529

Note: Do not attempt to view data on the remotely mounted server. Copy the VIs and the data to your 530

local hard drive before working on them. It was discovered through trial and error that it’s best to view the 531

data on a machine separate from the one that is taking data. Working non-locally with data or VIs while 532

an experiment is running may cause problems for you or the experiment. 533

8.2.2 Method 2: Using wget 534

If you have a unix-like operating system (Linux, Mac OS X), or use Cygwin on Windows, and are comfortable 535

on the command line, wget is an excellent tool to use. This method duplicates the directory structure of 536

hep-diskarray, which can be very convenient for maintaining consistency between your local copy and the 537

PXI Crate. Open a terminal and cd to a directory where you’d like to store your mirrored directories. 538

To mirror only the latest running VPT VI software, run: 539

wget -m "ftp://teststand:labview@hep-diskarray.physics.virginia.edu\ 540

/teststand/VPT Stability Scanner/v3.0 - 5 VPTs" 541

This will copy the VIs (*.vi) in the following directory structure to your working directory: 542

hep-diskarray.physics.virginia.edu/ 543

teststand/ 544

VPT Stability Scanner/ 545

v3.0 - 5 VPTs/ 546

C/ 547

... 548

FPGA Bitfiles/ 549

... 550

*.vi 551

If you don’t want to copy the directory structure and just want the VIs themselves, cd to your own 552

directory and run a command like the following to copy the desired files directly without the directory 553

structure above. 554

wget "ftp://teststand:labview@hep-diskarray.physics.virginia.edu\ 555

/teststand/VPT Stability Scanner/v3.0 - 5 VPTs/*.vi" 556

8.3 Getting the Latest Data 557

The location of the latest data is always subject to change. All data is usually located in a /data/ directory 558

under the particular experiment’s main directory on the RNAS, such as /teststand/VPT Stability Scanner/. 559

Check with the current experiment maintainer for the latest location. For demonstration purposes, we’ll 560

assume the latest data is located on the RNAS in the following files: 561

562

/teststand/VPT Stability Scanner/data/Taken with v3.0/Raw Data/ 563

VPT2181.dat 564

VPT2182.dat 565

VPT2183.dat 566

VPT2814.dat 567

VPT2185.dat 568
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8.3.1 Method 1: Using Finder 569

If hep-diskarray.physics.virginia.edu is not already mounted, mount it. If you’re not sure if it’s mounted: 570

1. Open Finder from the Dock. 571

2. Press ⇧⌘C 572

3. Look for hep-diskarray.physics.virginia.edu in the window presented. 573

Now you’re ready to locate and copy the data. 574

1. Navigate to hep-diskarray.physics.virginia.edu → teststand → VPT Stability Scanner → data → Taken with 575

v3.0 → Raw Data 576

2. Select VPT2181.dat through VPT2185.dat. 577

3. Copy them to a convenient location on your hard drive. 578

8.3.2 Method 2: Using wget 579

Note: The bash shell is assumed. 580

To mirror the most recent data for local viewing, run: 581

wget -m "ftp://teststand:labview@hep-diskarray.physics.virginia.edu\ 582

/teststand/VPT Stability Scanner/data/Taken with v3.0/Raw Data/VPT218[12345].dat" 583

If you don’t want to copy the directory structure, just drop the “-m” option. 584
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9 PXI Crate 585

9.1 Logging into the PXI Crate (RDP) 586

9.1.1 Mac 587

You’ll need to download and install Microsoft’s Remote Desktop Connection Client for Mac. 588

1. Launch Remote Desktop Connection for Mac. 589

2. In the “Computer:” field, enter the IP address 128.143.196.230. Press Connect. 590

3. When prompted, use the username administrator and password !UVAVPT 591

If desired, you can make local (Mac) hard drives and printers available to the PXI Crate while you’re 592

logged in by editing the connection. (File → Edit a Connection) 593

9.1.2 Linux 594

You’ll need to download and install rdesktop for accessing Windows Termainal Services. Rdesktop is available 595

through the package management systems of most distributions, such as Debian, Ubuntu, and Redhat. A 596

Gnome frontend to rdesktop is also available, called grdesktop. 597

These directions assume rdesktop: 598

1. [fixme]� 599

9.2 Launching LabVIEW 600

9.3 Opening Project VPT Stability 601

9.4 Starting Data Acquisition 602

1. Open the VPT Stability project as in §9.3. 603

2. Open the Host - Main.vi VI from the project file viewer. 604

3. Press the Run Once button. You will be prompted for information: 605

• VPT 1–5 reference numbers 606

• Angle in field (degrees) 607

• Min. wait time (seconds) 608

• Load on/off time (hours) 609

9.5 Stopping Data Acquisition 610

1. If necessary, log into the PXI crate as in §9.1 Logging into the PXI Crate (RDP). 611

2. Locate the Host - Main.vi window, listed under the Window menu of any LabVIEW window. The front 612

panel is preferable, but not necessary. 613

3. Hit the Stop button. 614

9.6 Restarting Data Acquisition 615

Follow this procedure if you were taking data and wish to start over with the same VPTs: 616

1. If desired, copy the old data files to a safe location. 617

2. Delete the original data files. 618

3. Begin following §9.4 Starting Data Acquisition. 619

http://www.microsoft.com/mac/products/remote-desktop/default.mspx
http://www.rdesktop.org/
http://www.gnome.org/
http://www.nongnu.org/grdesktop/
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9.7 Resuming Data Acquisition 620

Follow this procedure if you wish to resume recording data to the same files after an interruption: 621

1. If necessary, log into the PXI crate as in §9.1. 622

2. Locate one of the data files and open it in a text editor. Copy the first column of the last line. This 623

is the time offset to resume at. 624

3. If necessary, start LabVIEW (§9.2), open project VPT Stability (§9.3), and/or open Host - Main.vi. 625

4. On the top row of the Host - Main.vi front panel is a text input box labeled Test Start Time Offset. Click 626

to edit the contents and paste the time offset from step 2. 627

5. Press the Run Once button. When prompted, enter the original VPT numbers, and the rest of the 628

information as before. 629

9.8 Shutting Down The Crate (software) 630

Follow this procedure if you wish to shut down the PXI Crate to later reboot it: 631

1. If necessary, log into the PXI crate as in §9.1 Logging into the PXI Crate (RDP). 632

2. If necessary, shut down DAQ as in §9.5 Stopping Data Acquisition. 633

3. Close LabVIEW. [fixme]� menu commands; do not save VIs? 634

4. [fixme]� Click the start button and navigate to Start → Logout, then choose Power Off when prompted. 635

9.9 Powering On Hardware 636

1. Locate the power button on the lower left-hand side of the front of the PXI Crate. Next to the button 637

is an LED light. 638

2. If the light near the button is lit, the crate is already powered on. If it is not lit, press the power 639

button. 640

9.10 Powering Down Hardware 641

1. First perform a software shutdown as in §9.8 Shutting Down The Crate (software). 642

2. Check if the power LED is still lit. It is located on the lower left-hand side of the front of the PXI 643

Crate, near the power button. 644

3. If still powered, press the power button once. 645
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10 Low Voltage Supply 646

For operating instructions, including troubleshooting, reference the BK Precision 9130 User Manual, or the 647

BK Precision Model 9130 product page. 648

10.1 Panel Controls 649

The On/Off key controls the output state (on/off) of all three channels simultaneously. To control the output 650

state of an individual channel, use the number keys 1–3. 651

Use the 1–3 keys to set the output state of channels 1–3. Similarly, use 4–6 keys to set the voltage, and 652

7–9 keys to set the current for each channel. 653

10.2 Setting Voltage 654

There are three different methods to set the voltage: 655

1. Press V-set. Enter a numeric value with the keypad, then press Enter. 656

2. Press V-set. Then use the ↑↓ arrow keys to select a channel. Adjust the voltage with the knob. 657

3. Press the 4, 5, or 6 key to select channel 1, 2, or 3. Then enter a numerical value on the keypad. Then 658

press Enter. 659

10.3 Setting Current 660

There are three different methods to set the current. They are identical to the methods to set the voltage, 661

except that you press I-set instead of V-set, and the keys 7, 8, or 9 instead of 4, 5, or 6. 662

1. Press I-set. Enter a numeric value with the keypad, then press Enter. 663

2. Press I-set. Then use the ↑↓ arrow keys to select a channel. Adjust the voltage with the knob. 664

3. Press the 7, 8, or 9 key to select channel 1, 2, or 3. Then enter a numerical value on the keypad. Then 665

press Enter. 666

10.4 System Set 667

System Set is a menu available from the Menu button. One of the things it allows you to do is set channels 668

for series or parallel operation. Supply two should have Out Serial Set set to 1+3. For serial use, Ch1− should 669

be connected to Ch3+, and Ch1+ and Ch3− should connect to the load. (Ch 2+3 serial operation is not 670

permitted.) 671

http://www.bkprecision.com/products/model/9130/triple-output-programmable-dc-power-supply.html
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11 High Voltage Supply 672

All high voltage supply directions are carried out with the small LCD display and keyboard attached to the 673

large red CAEN Nuclear SY1527LC rack-mounted system. 674

11.1 Verifying Cable Configuration 675

Inspect the back of the high voltage unit. The module inserted in the middle, marked “12 CH POS” near 676

the bottom in blue, should have ten cables connected to channels 0 through 9. Verify the layout by reading 677

the cable labels and comparing them with Table 5 (p. 30). 678

Table 5: High Voltage Group 01

Channel Cable Label Channel Name Voltage Current
0 HV Anode 1 VPT1-Anode 800.00 V 20.00 µA
1 HV Dynode 1 VPT1-Dynode 600.00 V 20.00 µA
2 HV Anode 2 VPT2-Anode 800.00 V 20.00 µA
3 HV Dynode 2 VPT2-Dynode 600.00 V 20.00 µA
4 HV Anode 3 VPT3-Anode 800.00 V 20.00 µA
5 HV Dynode 3 VPT3-Dynode 600.00 V 20.00 µA
6 HV Anode 4 VPT4-Anode 800.00 V 20.00 µA
7 HV Dynode 4 VPT4-Dynode 600.00 V 20.00 µA
8 HV Anode 5 VPT5-Anode 800.00 V 20.00 µA
9 HV Dynode 5 VPT5-Dynode 600.00 V 20.00 µA

Inspect the rig inside the superconducting solenoidal magnet. When viewed from the rear, which faces 679

the exterior door, the high voltage cables enter from the front (opposite) side and are attached to the VPT 680

mounting rig on the left-hand side. Visually verify that the top five cables facing you are labeled “HV Anode 681

1” through “HV Anode 5” from top to bottom. Verify from the front side that the top five cables facing you 682

on the right-hand side are labeled “HV Dynode 1” through “HV Dynode 5.” 683

11.2 Verifying the Voltage Settings 684

From the front of the rack, examine the color LCD monitor below the high voltage unit. Verify that the 685

voltage settings correspond to Table 5 (p. 30). 686

11.3 Killing the High Voltage 687

⚠ AVOID killing the high voltage unless it’s worth the risk of damaging the equipment. 688

1. Turn the key to the off position. 689

✓ DO ramp the voltage down before shutting the system down whenever possible. See §11.4 Ramping 690

Down the High Voltage for ramp-down instructions. 691

11.4 Ramping Down the High Voltage 692

[fixme]� Placeholder until detailed walkthrough can be practiced 693

1. Toggle group mode from the Groups menu. 694

2. Turn off any channel; while group mode is enabled all grouped channels will ramp down together. 695
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11.5 Ramping Up the High Voltage 696

[fixme]� Placeholder until detailed walkthrough can be practiced 697

1. Toggle group mode from the Groups menu. 698

2. Turn on any channel; while group mode is enabled all grouped channels will ramp up together. 699

11.6 Turning Off the High Voltage System 700

The system rarely needs to be entirely turned off. Channel boards and power supplies may be hot swapped 701

and channels only need to be ramped down before disconnecting cables. However, there is an additional 702

safety factor in powering the entire system down before tampering with high voltage. 703

1. Ramp down the voltage (see 11.4, p. 30). 704

2. Turn the key to the off position. 705

11.7 Turning On the High Voltage System 706

To turn the high voltage on from a power-off state: 707

1. Turn the key to the local position. 708

2. Ramp up the voltage (see 11.5, p. 31). 709

Note: In the future, the key may need to be turned to remote. Check with the experiment maintainer if there are 710

additional cables connected to the front panel. 711
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12 Vaccum Photo-triodes (VPTs) 712

12.1 Cleaning 713

Only the photocathode face needs to be cleaned. Fingerprints should be wiped away using disposable lens 714

cloths. A small green cardboard box of Kimwipes Delicate Task Wipers is usually located near the rig for 715

easy access. 716

Figure 20: Kimtech Science Kimwipes

12.2 Mounting VPTs 717

Each VPT has three cables connected to the anode (tan/white), dynode (blue), and cathode (gold/yellow). 718

The cathode is sometimes labeled with the letter “K” from the Russian spelling. The dynode and cathode 719

colors can be remembered with the euphemistic mnemonic as “KY dB.” 720
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13 Maintainence 721

13.1 Schedule 722

This section lists tasks which must be done regularly to maintain the experimental equipment or ongoing 723

experiments. The following vocabulary is used in this section:

daily Once per day, at any time unless otherwise specified
semi-daily Every other day
biweekly Twice a week, or every 3-4 days
monthly Once per month

as needed As often as necessary; frequency determined by another maintenance step
724

13.1.1 Under All Conditions 725

The following tasks must be carried out whether or not an experiment is currently under way. 726

daily Measure cryogen levels
as needed Fill LN2 cryogen
as needed Fill LHe cryogen

monthly Measure magnetic field strength

13.1.2 Experiment: VPT Stability 727

The following tasks are only required during VPT Stability experiments. 728

daily Verify DAQ is still running
biweekly Examine data for experimental errors

13.2 Measuring Cryogen Levels 729

Cryogen levels should be checked daily. Under normal conditions the cryogen evaporation rate is virtually 730

constant. However, checking daily will reveal if a fill was done improperly, or if a quench occured. 731

1. Locate the cryogen lab notebook near the cryogen gauges. 732

2. Record the current date and time in the notebook. 733

3. Read the liquid nitrogen gauge, which is always on. Record the measurement in the notebook. 734

4. To begin taking a liquid helium measurement, press the green power button to turn on the gauge. 735

5. Wait several seconds, then press the black “MAN” button to take a measurement. The “Sample” light 736

will light up. 737

6. Wait until the “Sample” light goes out, then read the measurement from the LCD display. It’s a 738

percentage. 739

7. Record the LHe measurement in the notebook. 740

8. Press the green power button to turn off the LHe gauge. 741

✗ DO NOT leave the liquid helium gauge powered on. It will unnecessarily heat the cryogens and cause 742

them to boil off more rapidly. 743
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13.3 Filling LN2 Cryogen 744

✓ DO consider filling Monday and Friday, and always well before reaching 10 % capacity. 745

1. Measure and log the cryogen levels, as in §13.2. 746

2. Climb up the ladder and unscrew the wingnut from the c-clamp at the base of the black ventilation 747

tower. 748

3. Remove the c-clamp, ventilation tower, and the o-ring beneath the tower. 749

4. Climb down and slowly turn the blue valve (connected by pipe to the magnet). Allow the LN2 to flow 750

slowly at first to cool the valve and piping, then open the valve all the way. A constant plume of white 751

vapour will shoot from the valve where the ventilation tower was removed. 752

5. Return to the LN2 gauge and monitor the fill. It takes 10min on average to fill 25%. 753

6. Dust frost off the ventillation tower valve every 5–10min or so. 754

7. Once the gauge reaches 100%, return to the LN2 dewar and shut off the blue valve. 755

8. Climb up the ladder and thoroughly clean the tower valve. 756

9. Replace the o-ring, ventillation tower, and re-attach the c-clamp. 757

10. Firmly tighten the wingnut on the c-clamp by hand. 758

11. Return to the cryogen gauges and record the 100% LN2 level, as in §13.2. 759

✗ DO NOT forget to replace the o-ring. Failing to replace the o-ring is the easiest mistake to make during 760

an LN2 fill and will cause LN2 to boil off more rapidly. 761

✓ DO move the empty dewar through the computer room and out the doors to the concrete patio. 762

13.4 Ordering LN2 Cryogen 763

[fixme]� Chris in the stock room in the Beams building handles orders. 764

13.5 Filling LHe Cryogen 765

✓ DO fill between 20–30 % capacity to use an entire LHe dewar. 766

[fixme]�Placeholder for practiced fill 767

768

✓ DO move the empty dewar through the computer room and out the doors to the concrete patio. 769

13.6 Ordering LHe Cryogen 770

Mike (HEP) handles orders. Takes 2–3 weeks. 771
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Glossary 772

BNC: A common type of RF connector for terminating coaxial cable. Cables terminated at both ends 773

by BNC connectors are colloquially called BNC cables. BNC connectors are 50 Ω terminators. BNC 774

stands for Bayonet Neill-Concelman. « 5 » 775

DAQ: An abbreviation for Data Acquisition, DAQ refers to the process of capturing digital representations 776

of physical processes. By definition DAQ, involves (typically analog) sensors, circuitry to translate the 777

analog signal into a digitizable form, and an ADC (Analog to Digital Converter). Colloquially, DAQ 778

can also refer to the process of capturing those digital signals and recording them. « 18 » 779

FPGA: Field Programmable Gate Array: A Reconfigurable I/O (RIO) device; essentially a programmable 780

integrated circuit (IC). It can be programmed through LabVIEW (from the system controller only) to 781

provide real-time signalling, triggering, or processing. « 3, 19 » 782

LabVIEW: Software development environment created by National Instruments’ for building and deploying 783

programs, called Virtual Instruments, written in the visual programming langauge G. « 2, 24 » 784

LED board: LED pulser board designed and built by Mike Arenton. Receives electrical triggers from the 785

PXI Crate and sends optical pulses to the VPTs and PIN diodes. « 3 » 786

MOLEX: Molex is a large supplier of electronic interconnects. Molex connector is a vernacular term for 787

the two-piece interconnects manufactured by Molex. « 5 » 788

NI: National Instruments « 18, 19 » 789

PXI Crate: The National Instruments crate and contents, including hardware modules and software to 790

control the experiment and perform data acquisition (DAQ). « 3, 18, 22, 24, 25 » 791

quench: An abnormal termination of magnet operation, caused by part of the superconducting material 792

entering the normal resistive state. A quench has not yet occured under HEP supervision. A quench 793

should not damage the magnet itself, but it can induce kilo-volt spikes and arcing and the rapid boil-off 794

of cryogens can cause asphyxiation. « 33 » 795

ReadyNAS: See RNAS « 19 » 796

rig: Aluminum mounting brace attached to the supersolenoidal magnet, housing the LED pulser boards, 797

VPT mounting enclosure, and anode amplifier boards. « 3 » 798

RNAS: ReadyNAS, a specific NAS product produced by Netgear. RNAS is a specific independent hardware 799

module located in the HEP Computer Room [fixme]�. « 22, 35 » 800

System Controller: Generic term for the device that is housed in slot ..1 of a National Instruments PXI 801

chasis. This is almost always an Embedded Computer. « 19 » 802

VI: Virtual Instrument « 20 » 803

VPT: Vacuum Photo-Triodes « 9 » 804

VPT VI: Literally Vacuum Photo-triode Virtual Instruments; Refers to the HEP software written in Lab- 805

VIEW for the National Instruments hardware. Includes software and hardware logic. « 24, 25 » 806
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